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1 About This Guide 

This document is intended as a supplement to formal training. DataCan is constantly working to 

improve its products. We must therefore reserve the right to change designs, materials, 

specifications and prices without notice. DataCan declines any liability that may arise out of the 

potential inaccuracies in this guide. 

 

This guide assumes that you have some computing and tool knowledge. For more information, 

contact your local service representative. 

www.datacan.ca 

info@datacan.ca  

 

We thank you for any feedback or comments that will help us to continue to improve our 

products and service. 

  

http://www.datacan.ca/
mailto:info@datacan.ca
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2 Introduction  

DataCan Services Corp. provides technology driven downhole measurement solutions that 

deliver productivity, quality and safety. We design, manufacture and service 200°C plus hybrid 

platform instruments, patent pending multi-cycle instant close shut-in tools, reservoir 

management systems and a suite of quartz and piezo-resistive pressure measurement 

instruments. We offer specialized solutions that will help you improve productivity in your 

applications. 

 

We are the leader in ultra-high temperature circuit design, manufacturing and packaging.  

• Our part selection process ensures the best long term reliability is provided. 

• Our fully automated surface mount assembly procedures ensure the highest quality 

circuit is constructed every time with minimal heat impact. 

• Our Hybrid design and construction techniques will enable DataCan and its customers to 

reliably enter the 177ºC to 225ºC market. 

• Our metal to metal seal and fully welded designs prevent potential leaks. 
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3 Product Description 

DataCan’s program and download software operates and controls all of DataCan’s downhole and 

surface products. The software can be used to program tools, download the information stored 

on the tool memory, graph tool data, and create reports containing relevant job information. The 

software runs on Windows XP/Vista/7/8/10. 

 

3.1 Purpose 

DataCan download software is designed to be as user friendly as possible while offering features 

not found on the competition’s communication software. 

 

DataCan’s products are designed to store data to memory. Whether the memory is located 

downhole inside of a memory recorder, or at the surface in a surface read out box or multi-

channel logger, the architecture of the data storage and retrieval remains the same. 

 

DataCan stores data in “Jobs”. One job has a start time and end time. For a memory pressure 

gauge, the start time is when the operator plugs the battery onto the pressure gauge. The end 

time for a memory pressure gauge is when the battery or power supply is removed from the 

gauge.  

 

The act of powering the tool starts the tool and the program sequence. If you remove power 

from a tool then re-establish power, the program will restart as well. 
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Jobs can be downloaded individually or as a set. Jobs can be merged together. Jobs are not 

deleted by the act of re-programming the tool. The only way to delete a job is to instruct the 

software to perform the delete jobs command. You must delete all of the jobs at once. 

 

You can sample any pressure gauge, surface box, or logger in real time and save files in real time 

to a remote location. 
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4 DataCan Download Software Installation  

Please read the DataCan Software Install guide for the specific operating system you are using 

for more details. 

 

Each tool shipment comes with a DataCan USB Flash Drive that contains all of the files you need 

to install the software program and USB drivers.  

 

Before installing DataCan Download Software, you should have your computer ready with one of 

the following operating systems: Windows XP/Vista/7/8/10. 

 

To install DataCan Software from the Flash Drive: 

• Insert the Flash Drive into a USB Port 

• Open the DataCan Download Software folder.  

• Double click the setup.exe file to launch the DataCan Software installation. 

• Follow the instructions leading to the completion of the software installation. 

 

New releases are available for download on our website https://www.datacan.ca/downloads. 

  

https://www.datacan.ca/downloads
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4.1 Configuration File 

If the download software is being installed to multiple computers and the IT department would 

like the same defaults used for each computer, a configuration file can be saved and deployed. 

 

Set up the download software on one computer with all of the settings the way that the user 

would like. Then close the download software. 

 

In the Public User’s “Documents” or “My Documents” folder for that user, there is a “DataCan” 

directory which contains the “DownloadSoftware.conf” file. 

 

In XP: C:\Documents and Settings\All Users\Documents\DataCan\DownloadSoftware.conf 

In Vista / 7: C:\Users\Public\Documents\DataCan\DownloadSoftware.conf 

 

Install the download software on each computer. Open the software and close the software. 

Then replace the same .conf file on each user’s computer with the “DownloadSoftware.conf” file 

from the first computer. 

4.2 Installing the Download Cable Drivers Windows 

Please read the Quick Driver Install RevX_X.pdf guide for download cable driver installation. 
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5 Getting Started 

DataCan download software contains five main sections. Navigate between the five different 

sections by clicking the buttons shown below. The active section’s button is highlighted green. 

 

 

 

The five sections are as follows: 

Info – See information about the connected tool. 

Program –Program the tool. 

Download –Download data from the tool memory. 
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Graph – Create graphs and tables of the downloaded data. 

Reporting – Create detailed reports of job information. 

 

The software also has five menus containing additional features. Navigate between the five 

menus by clicking the menu title shown below. 

 

 

The five menus are as follows: 

Graph – Open, close and save jobs in graph and tabular form in the Graph Section. 

Configuration – Change the settings of the connected tool. 

Utilities – Calculate battery usage and perform real time sampling with the connected tool. 

Language – Switch between English, Mandarin Chinese, and German languages. 

Help – View graph help and software version details. 
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6 Connecting The Tool 

Once the DataCan Download Software and the USB drivers have been installed you are ready to 

initiate communication with the tool. 

 

Connect the green tool connection end of the DataCan Communication Cable to the gauge, 

surface box, or data logger. Connect the USB end to a receptacle on your computer. 

   

Open DataCan Download Software. You will be directed to the info page shown below. Click on 

the Connect button. 
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Once the software has established communication with the pressure gauge the Tool Model, 

Serial Number, Max Calibration Pressure, Max Calibration Temperature and Sample Capacity  

fields will fill with information from the tool. 



 

 

Copyright 2020 

 

Page 21 of 

193 

 

 

 

 

To edit the tool information fields enter supervisor mode by pressing Ctrl + Shift + D 

simultaneously on the keyboard. The background of the fields will change from grey to white 

and you will be able to enter the required information. It is necessary to save the new 

information by pressing the Save Notes to Tool button that appears only when in supervisor 

mode. 
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A pop up window will indicate when the changes have been made. Click OK. 

 

 

The Notes section was added for the operator to manually capture other information such as job 

details, job location or reminders. To save your notes to the tool memory you must click the 
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Program Tool button (see next section) or use the same procedure as changing the tool 

information. 

 

To disconnect the tool from the PC simply press the Disconnect button and unplug the tool. 
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7 Programming the Tool 

Enter the Program section by clicking on the following icon. Here you can create programs and 

store programs to the tool memory.  
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7.1 Before Programming the Tool 

For all memory gauges, the first step is always set to 1 second / sample for 64 seconds.  This is 

so that the light (LED) on the battery flashes once per second and so that after 64 seconds there 

is data in the memory.  This is a default step and cannot be changed. 

 

There is one more default program step.  At the end of your program, the gauge will sample at 

30 seconds / sample.  If your program is 1 hour long and you run a job for 1 day, then the tool 

will run at your programmed sample rate for 1 hour and then the next 23 hours will be run at 30 

seconds / sample. 

 

DataCan piezo pressure gauges write to memory every 8 samples. Hence, if you choose to enter 

a sample rate of 1 sample an hour, you will need to power the tool for 8 hours before any data 

will be written to the permanent non-volatile gauge memory. 

 

If your sample rate is 30 seconds then 30 * 8 = 240 seconds (4 minutes).  

7.2 Single Rate Program 

To create a program using a single sample rate select the Single Rate in Seconds radio button 

under the Program Sample Rates heading. Enter the desired sample rate in the field provided. 

For example, if 3 is entered the tool will sample once every three seconds. The Total Samples in 

Program, Battery Usage of Program, Total Samples in Memory, and Remaining Samples in 

Memory will be calculated automatically. The Memory Usage Meter visually displays the 

percentage the samples of memory have used from the total. Click the Program Tool button to 

save the program to the tool memory.  
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A pop up window will appear when the program has been loaded on the tool. Click OK. 

 

 

 

A DataCan Gauge Program Sheet will pop up which shows the details of the program entered 

into the tool memory. You can either choose to discard the sheet or save it to the PC as a pdf 

file. If you choose to save the sheet enter your name in the blank field provided and press the 
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Save button. This creates a record of the tool program that can be referred to when the tool is in 

operation.  
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7.3 Multiple Sample Rate Program 

To create a program using multiple sample rates select the Multiple Rates radio button under 

the Program Sample Rates heading. Enter the desired sample rates and durations in the fields 

provided. Up to 16 steps can be entered in the program. When all the programs are completed 

the tool will default to 30-second sample rate and continue until the memory is full. 

 The Total Samples in Program and Battery Usage of Program will be calculated 

automatically. Click the Program Tool button to save the program to the tool memory. 
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When the programming is complete a pop up window will tell you the tool memory has been 

programmed successfully. Press OK. 

 

 

 

A DataCan Gauge Program Sheet will pop up which shows the details of the program entered 

into the tool memory. You can either choose to discard the sheet or save it to the PC as a pdf 

file. If you choose to save the sheet enter your name in the blank field provided and press the 

Save button. This creates a record of the tool program that can be referred to when the tool is in 

operation. The sheet also shows the overrun time which is the time it takes to fill the tool 

memory after all the program steps have completed and the default sample rate of 30 seconds 

kicks in. 
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7.4 Burst Gauge Programming 

The Burst Gauge is programmed like any other memory gauge with the addition of a “Trigger 

Mode”. The trigger mode has 4 different options: 

 Off – This mode stores pressure, temperature and time like a standard memory gauge. 

No triggers are enabled in this mode. 

 Absolute P (or “Level Mode”) 

 Delta P (or “Window Mode”)  

 Calibration 

 

For each program step, the gauge will not change to the next program step until the 

programmed Duration time is reached. 

7.4.1 Pre-Burst Data 

When the gauge is in Absolute P or Delta P mode, the gauge will sample at 10 kHz to determine 

if a trigger is found. Once a trigger is found, 0.6 seconds of the 10 kHz data is stored with the 

burst memory as pre-burst data. 
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7.4.2 Off Mode 

This mode stores pressure, temperature and time like a standard memory gauge. No triggers are 

enabled in this mode. 

7.4.3 Absolute P (“Level”) mode 

This is one of two pressure triggered modes. The data is stored to memory at the sample rate set 

in the program page under “Sample Rate” until a trigger is found. 

 

To the right of the main program window, if the user clicks on the button labeled “AbsoluteP”, 

the options for this mode will appear underneath. 
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The trigger pressure is programmed in the box labeled “Absolute Pressure Level”. Once the 

measured pressure goes above this level, the gauge will sample at the rate set in “Burst Rate” 

until the burst memory is full. 

 

The “Level Timeout” is the number of seconds after a burst has completed until the gauge will 

ignore any other pressure triggers. This feature is so that if the well pressure remains above the 

burst threshold longer than the time that it takes to record one burst event, the gauge does not 

record a second burst event immediately. To disable this feature, enter a value of zero in this 

field. 
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7.4.4 Delta P (“Window”) Mode 

This is the second of two pressure triggered modes. The data is stored to memory at the sample 

rate set in the program page under “Sample Rate” until a trigger is found. 

 

To the right of the main program window, if the user clicks on the button labeled “DeltaP”, the 

options for this mode will appear underneath. 

 

The trigger pressure is programmed in the box labeled “Pressure Change”. The gauge pressure is 

measured in small windows that have a length of “Window Length”. If during one of these 

windows, the pressure changes more than “Pressure Change”, a burst even occurs and the gauge 

samples at the rate set in “Burst Rate” until the burst memory is full. 
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7.4.5 Calibration Mode 

Used internally by DataCan to calibrate both the slow and high speed sensor circuits. 

7.5 Piezo Pressure Gauge with Pressure Trigger 

Programming 

The Piezo Pressure Gauge with Pressure Trigger has two programming modes: 

1) “Off” – Normal mode. 

2) “On” – Pressure triggered mode. 

 

7.5.1 “Off” Mode 

“Off” mode acts like a normal piezo pressure gauge. The gauge will same at the programmed 

sample rate for the programmed duration. 
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7.5.2 “On” Mode 

“On” mode allows will sample to memory at the programmed sample rate until a trigger event 

occurs. Then the gauge samples at 1 sample per second until the stability criteria is met. 

 

Before the trigger event, the gauge will run at the programmed sample rate until either: a trigger 

occurs, the memory is full or the battery dies. 

 

At the beginning of each “On” program step, the current well pressure is saved by the gauge. 

The “Trigger Window” pressure is added to this first pressure and subtracted from this pressure 

to determine the maximum and minimum pressure that will cause the trigger to occur. 

 

Once the trigger is found, the gauge will sample at 1 sample per second until the pressure is 

stable within the programmed “Stability Window” for the programmed “Time for Stability”. In this 

example, the pressure would have to be within +/- 2.0 psia for 60 seconds before the gauge 

would exit this program step. 

 

At the end of the stability period, the gauge advances to the next program step. 

7.6 Quartz Pressure Recorder with Pressure Trigger 

This optional feature on some quartz pressure recorders allows the user to program a faster 

sample rate when the pressure is above a programmed pressure. 



 

 

Copyright 2020 

 

Page 37 of 

193 

 

 

 

To enable the trigger, check the Triggered? box in the right column on the Program page. 

 

Each program step with the Triggered? box checked will use the trigger program in the grid 

below. 
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Once the measured well pressure is above the Trigger Pressure, the gauge will start sampling at 

the trigger mode Sample Rate for the trigger mode Duration. 
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In the above example, during the second program step the gauge will sample at 5 seconds per 

sample. If the measured pressure ever goes above 10000 psia, the gauge will sample at a rate of 

0.1 seconds per sample for 10 minutes. 

 

When the programming is complete, press the Program Tool button to save this to the gauge. 

7.7 Save Program as PDF 

You can quickly and easily view and save the program as a pdf. This function is useful when the 

program information needs to be viewed and saved in document format immediately. 

 

To quickly and easily save a pdf, select Single Rates in Seconds or Multiple Rates (both will 

produce a different pdf document).   

 

When the Single Rates in Seconds option is selected, click the Save Program as PDF button. 
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A DataCan Gauge Program Sheet will pop up, as a pdf, which shows the details of the program 

entered into the tool memory. You can choose to discard the pdf without saving a copy, or save 

a copy to the PC, or print the pdf. This creates a record of the tool program that can be referred 

to when the tool is in operation.  
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When the Multiple Rates option is selected, click the Save Program as PDF button. 
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A DataCan Gauge Program Sheet will pop up, as a pdf, which shows the details of the program 

entered into the tool memory. You can choose to discard the pdf without saving a copy, or save 

a copy to the PC, or print the pdf. This creates a record of the tool program that can be referred 

to when the tool is in operation. The sheet also shows the overrun time which is the time it takes 

to fill the tool memory after all the program steps have completed and the default sample rate of 

30 seconds kicks in. 
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7.8 Export Program to File 

You can save a program to your PC for future use. This function is useful when a program is to 

be entered into an entire fleet of tools and the programmer does not want to manually program 

each individual tool. 

 

After creating the program, click on the Export Program To File button.  

 

 

Enter a file name and location to save the file and press the Save button. It will be saved as a text 

file. 
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7.9 Import Program from File 

Programs saved to the PC can be imported into DataCan Download Software so they can be 

loaded into the tool memory. 

To import a saved program click on the Import Program From File button. 

 

Select the program file you want to import and press Open. 
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The stored program will show up in the Program Sample Rates section. Remember to hit the 

Program Tool button to save the program to load the program to the gauge. 
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7.10 Jobs in Tool Memory 

Enter the Download section by clicking on the following icon. Here you can view recorded jobs 

and download data. 

 

 

 

The Jobs in Tool Memory section lists the jobs recorded in the tool memory when the tool is 

connected to the PC. Number of samples, maximum pressure, maximum temperature, and 

duration columns are updated once the data is downloaded from the tool. 
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7.10.1 Main Memory and Burst Memory Remaining 

The percentage of the memory that is full is shown in a bar graph on the right side of the 

download screen. For the Burst Gauge, the amount of burst memory that is used is also shown 

here. The Burst Gauge can have a total of 8 burst events stored. If the user is going to run a job 

that requires more memory than is available, please download and erase all the jobs in memory. 

 

7.11 Download Data 

 

Select the check box next to the jobs that you want to download to your PC and click the 

Download button. 
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A pop up window will ask you if you want to append the files. If you click on the Yes button it 

will save the multiple jobs to the PC as a single file. If you click the No button it will save the jobs 

as individual files. Click No (it is better to append the files in the Graph portion of the software). 
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Select a location to save the data file from the tool. Press the Save button. 

 

Select the start date and time that the tool battery was connected based on your records. Click 

OK to save the file. 

 

When the jobs are finished downloading a pop up window will tell you that the download was 

successful. Click OK. 
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Notice that number of samples, maximum pressure, maximum temperature, and duration 

columns are now updated after the data is downloaded from the tool. 

 

The software automatically converted the data file to a text (ASCII) file based on the settings (see 

Configuration section shown below) saved in the tool memory. To change Units, please refer to 

the Configuration Menu in Section 8.2.  
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7.11.1 Burst Gauge Download 

If there are burst events tied to a job being downloaded for the burst gauge, the burst event(s) 

will be downloaded automatically at the completion of the main job download. 

 

Each burst event is stored in a separate file than the main job. As an example, if a job has 2 burst 

events, then 3 total files will be created: one for the main job and one for each of the two burst 

events. 

7.12 Add a Default Download Folder 

To force the software to save all downloaded files to a specific location on your computer, a 

default download folder can be selected. 

  

 

To do this, put a check mark beside “Always use the default download folder”. Next, click the 

“Change” button and select the folder you would like to use.  
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7.10 Erase Jobs from Memory 

When the data from the tool has been downloaded onto a PC you can erase the jobs contained 

within the tool memory. This frees up space in the tool memory for future jobs. 

 

To erase the jobs from the memory, select the Erase All Jobs button.  

 

 

A window will appear that confirms you want to delete all of the jobs from the tool. Click Yes to 

proceed. 

 



 

 

Copyright 2020 

 

Page 54 of 

193 

 

 

IMPORTANT: You cannot erase individual jobs as this would result in fragmented memory. You 

must erase all jobs at once. 

Do not disconnect until complete. 



 

 

Copyright 2020 

 

Page 55 of 

193 

 

 

8 Configuration 

On the top menu bar, hitting the Configuration Button, and be directed to the following page. 

 

The configuration tab allows advanced users to save new units to the gauge, auto load 

downloaded files to the graphing screen, convert files raw count files into real values, turn on or 

off the atmospheric correction, load calibration files and format the memory. 

 

8.1 Supervisor Mode 

Some of the functions in the configuration tab are inaccessible. To access all of the features of 

the configuration menu, you must enter “Supervisor Mode”. To do so, you need to hold down 

the “Control”, “Shift”, and the “D” key. By pressing these three keys again, you can exit out of 

Supervisor Mode. 

 

When you enter Supervisor Mode, the title bar changes, after the gauge serial number you can 

now see “Supervisor Mode”. 

 

Also, the “Calibration Date” File is no longer grayed out; you can move your cursor over the 

Calibration Date window and change the calibration date. To save the new calibration date to the 

tool, you must hit the “Save Notes to Tool” button. 
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You can also enter any notes, like job details, or tool history, into the notes section. Again, you 

must hit the “Save Notes to Tool”  

 

 

The line shift and/or scale functionality in the graph view is only available in this mode as well. 

Please refer to the “Adjusting the Line Shift/Scale Properties” section of this manual. 

 

Another option available in this mode is the ability to convert binary data files and download 

jobs in “Raw Counts”. Simply select the “Raw Counts” option from the Configuration menu in 

Supervisor mode prior to downloading or converting a file. 
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8.2 Change Units 

To Change units, connect the gauge to the software, then select the “Change Units” option from 

the Configuration menu bar at the top. The following dialog box will appear: 

 

Choose the units and time format that you prefer and hit the “Save” button. The number of 

decimal places displayed for pressure can also be changed here. 
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8.3 Convert File 

If you ever need to apply a new calibration curve to old data, or vice versa, follow these steps. 

 

The gauge may be or may not be connected to convert binary data files. 

To convert a file without connecting the gauge, the calibration files are required. 

 

Click the “Configuration” item in the menu bar at the top. Then click “Convert File”. Two options 

are displayed. If the tool is not connected, select the “Gauge is NOT connected” option. 

 

 
 

 

 

The following dialog box will appear. Select the tool type here. 

 

 
 

Next, the Change Unit dialog box appears allowing you to select the units you want for the text 

file to be created. 

 



 

 

Copyright 2020 

 

Page 59 of 

193 

 

 

 
 

The next step is to select the calibration file for the tool type selected IF the tool is not 

connected. If the tool is connected, you will not be asked to select a calibration file. 

 
 

Now select the Binary Data file that you would like to convert. 
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Last, choose a location to save the converted file. 

 
 

Once the Save button is clicked the following dialog box appears. Choose the appropriate start 

date and time then click OK. 
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If the conversion was succussfully completed, a message confirming the success will be 

displayed. 

8.4 Default File Output Format 

To change the default file delimiter option for all downloading and converting done in the 

software, simply select the desired option from the Configuration Menu. Once selected, this 

option remains the same until changed by the user. 

 

 

8.5 Load Calibration Files 

To load a new calibration file onto into a memory tool or permanent / SRO surface box, follow 

these steps. 
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Open the DataCan Download Software and connect to the gauge. Press “CTRL+SHIFT+D” to 

enter “Supervisor Mode”. In the menu at the top, click on “Configuration”. Next, click “Calibration 

Files” and “Load Cal Files”.

 
 

Navigate to the flash drive that we sent with the gauges and into the “Calibrations” folder (or to 

the files you have saved in other locations). 

 

Click “OK”.  Once programming is completed, you can re-download any data that you have on 

the gauge. 

 

8.6 Load Calibration Files – Memory Quartz 

If a different quartz memory module / quartz transducer combination is used, connect the 

combination to the DataCan Download Software. On connect, the software will prompt the user 
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that a different quartz transducer is connected and ask the user if they would like to save the 

calibration files. Allow the software to do so. 

8.7 Download Calibration Files (Piezo and/or Quartz Tool) 

To download the calibration from a memory tool, follow these steps. 

Open the DataCan Download Software and connect to the gauge. Press “CTRL+SHIFT+D” to 

enter “Supervisor Mode”. In the menu at the top, click on “Configuration”. Next, click “Calibration 

Files” and “Load Cal Files”. 

 

 

 

Navigate to a location on the computer to save the Calibration File (.cff) and associated files from 

the memory tool. 
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Click “OK”.  The Calibration File downloaded from the tool can be used when loading calibration 

files onto the tool. 

 

8.8 Data Smoothing 

The data smoothing option is designed to remove and noise from the recorded data while still 

preserving the true meaning of the samples. 

 

The smoothing works differently for pressure and for temperature. For temperature, a rolling 

average of “Sample Length” samples is taken. For pressure, that same “Sample Length” is used, 

but the data is only smoothed if the data does not change from one point to the next by the 

pressure specified in “Threshold”.  

The data smoothing can remove some features in the data if not set up correctly. 

To enter the “Data Smoothing” configuration screen, click “Configuration” in the menu and then 

click “Data Smoothing”. 
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8.9 Atmospheric Correction 

Piezo gauges have a minimum pressure threshold before they read accurate pressure. This 

threshold is normally slightly above atmosphere.  The gauges are designed to read very 

accurately above this threshold. 

  

The software can force readings below this threshold to read atmosphere. Once the data is 

above the threshold, where it is calibrated to read correctly, the data will not be affected by the 

software. 

  

In the DataCan Download Software, press “CTRL+SHIFT+D” to get into “Supervisor 

Mode”.  Connect to the gauge.  In the menu bar at the top, click “Configuration” then click 

“Atmospheric Correction” to turn this option on. 

 

This setting is stored in the software and will be remembered for the next time the software is 

opened. 
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8.10 Replacing the Memory Module (Quartz Tool Only) 

When the memory module is replaced the calibration files and the transducer serial number 

MUST be loaded into the memory module. This is now done automatically by the software on 

connect. The user must say “Yes” when prompted. 

 

Connect the tool with the new memory module attached to the computer as outlined in Section 

5.2. When the software asks if you would like the memory module to automatically be updated, 

click the “Yes” button. The software will then do everything for you. 



 

 

Copyright 2020 

 

Page 68 of 

193 
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9 Graph  

Enter the Graph section by clicking on the following button.  
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9.1 About the Graph 

The graphing section is used to manipulate and present data in a graphical format. Here you can: 

• Delete portions of the data to remove the beginning and end portions of a job that are 

not useful. 

• Filter the data to reduce the file size. 

• View multiple data sets at one time. 

• View a difference plot to see if two gauges are tracking each other.  

• Zoom in and out of the graph to look at pressure, temperature, acceleration, or other 

data variances. 

• Modify the data to adjust for gauge annomolies.  

• Change the start time to align multiple data sets.  

• Create a gradient plot and make annotations for a report. 

There are 5 main areas of the graphing screen:  
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1) The view tabs 2) The action buttons 3) The legend 4) The graph 5) The data table. 

 

At any time, you can move your mouse to one of the section boards and adjust the size of each 

section.  

 

The view tabs allow you to move from the main data graph to the gradient table and gradient 

graph and to the difference graph. 

 

The action buttons on the top side perform a variety of useful functions. You can select large 

portions of data to delete or filter. You can move to full screen mode, undo changes you make, 

and save the data file. Each action button is described as follows: 
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 Open  
 

Left Boundary 

 Save As  
 

Reset Lines 

 Close All Graphs  
 

Right Boundary 

 Quick Print  
 

Filter 

 Full Screen Mode  
 

Delete 

 Undo  
 

Units / Settings 

 Redo    

 

The legend is important when graphing multiple plots of data. You can select which data sets to 

view, you can change the color and size of the respective data curves, and you can adjust the 

start dates for each data set. 

 

The graphing section displays a graph of the data. The blue curve is defaulted to the pressure 

data, the red curve is defaulted to temperature data. The pressure scale is automatically 

generated on the left and the temperature scale is automatically generated on the right. The 

bottom of the graph shows the time as it was recorded in the data file. A right click of the mouse 

button over the graph pops up another menu of actions for the user to perform. 

 

The data table at the bottom right side of the graph screen shows a table from the active data 

file. 
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9.2 Open Graph from Data File 

There are two ways that you can load a data set into the graph. First, you can load a graph from 

a data file located on your computer. Second, you can automatically load the data that you 

downloaded from your gauge. 

 

You may create a graph from any file that you have downloaded and saved to your computer as 

previously outlined in downloading section of this manual. 

 

Click on the Graph button and go to File >Open 

 

 

This brings up the browse window. Select the file you want to graph and click Open 
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9.2.1 Open Graph From Data File – Quick Button 

The second way to open a graph is by using the Quick Button  on the top of the graph as 

highlighted in the image below. 

 

9.2.2 Open Graph From Data File – Drag and Drop 

The third way to open a graph is to open the folder containing your text file in Windows 

Explorer. Drag the file from Windows Explorer into the graph screen in the DataCan Download 

Software. 
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To add another data file to the graph, repeat the above process. You can add up to 4 different 

data sets. 

9.3 Append Data 

Two or more data files can be placed one after the other by using the append feature. This 

occurs when more than one data file are opened with the same gauge serial number(s). 

There are two options when appending data: 

1) Concurrent Time – This feature ignores the start time of the appended data. Instead the 

first data set of appended files is started immediately following the last data set in the 

first file. 
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2) Keep Start Times – All data from each data set retains its original time stamp. If there is 

a large time gap between the two (or more) data sets, the gap will still remain in the 

data. 

9.3.1 Concurrent Time 

In the menu, select “File -> Open”. You can either select multiple files with the same serial 

number or you can repeat the “File -> Open” process to open a second file with the same serial 

number. 

 

Select the file you would like to append and click the “Open” button. 

 

 

A new dialog pops up. Click “Append (Concurrent Time)” and click the “OK” button. 
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9.3.2 Keep Start Times 

In the menu, select “File -> Open”. You can either select multiple files with the same serial 

number or you can repeat the “File -> Open” process to open a second file with the same serial 

number. 

 

 

Select the file you would like to append and click the “Open” button. 
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A new dialog pops up. Click “Append (Keep Start Time)” and click the “OK” button. 

 

 

9.4 Close All Graphs 

To close the graphs that you have opened press File and go to Close All Graphs. 
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9.4.1 Close All Graphs – Quick Button 

Alternatively, you can close all graphs by using the Quick Button  located on the top side of 

the graph screen. 

 

9.5 Open Graph Automatically 

A graph can automatically be created when the data is downloaded from the tool onto your 

computer by using the Autograph feature.  
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By default, the autograph feature is turned off. The reason is that it takes more of your computer 

processing power to download the data and plot the data at the same time. In most cases, 

customers download data and then create the graph or report at a different time.  

If multiple jobs are downloaded simultaneously only the last job selected In Tool Memory 

list will be graphed. 

This feature is enabled in the “Download” section of the software.

 

Activate the Autograph feature by selecting the check box beside Auto load job to graph? 

 

Once the “Auto load job to graph” option is activated, then the downloaded jobs will 

automatically appear in the graph screen after the data is downloaded from the tool. 
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9.6 Graph Setup 

The graph setup allows you to change the graph units, change data grid and annotations 

visibility settings. Enter graph setup by clicking the Quick Button  located on the top side of 

the graph screen as highlighted in the image below. 
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Change the available options to what suits your jobs needs and click the Update button at the 

bottom of the tab. 

9.6.1 Graph Time Format 

This option will change both how the graph is displayed as well as the time and date columns 

stored in the data file. 

Real Time – The graph axis and data file show a calendar date and clock time. 

Elapsed Time – The graph axis and data file show the elapsed time, or the time starting when 

the battery was plugged in (time zero). 
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Both – Date, Real Time and Elapsed Time columns are stored in the data file. The graph time axis 

is in Real Time. 

9.6.2 Elapsed Time Units 

This can be in either: seconds, minutes, hours or days. 

9.6.3 Pressure Units and Temperature Units 

Change to the desired unit of measurement for pressure or temperature. 

9.6.4 Decimal Places for Pressure 

The number of digitals after the decimal place can be changed for pressure. 

9.6.5 Length Units 

This changes the units used for the depth when using gradient points. 

9.6.6 Default Line Width 

The user can change how thick each plotted line appears. 

9.6.7 Annotation Settings 

This option will change how graph annotations are displayed. 

Text (Default) – Event text will be shown in the annotation. 

Numeric Annotations – A number representing the order in which the point appears in the 

graph. Displaying a number instead of text can minimize the chance of the text overlapping on 

the graph. The number displayed for each annotation / gradient is the same as the index used in 

the Events Table. 

Time/Press/Temp/Text – The event annotation will include the Time, Pressure, and 

Temperature of the data for the corresponding event, followed by the event text. 
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Gradients annotations will always contain Depth, Pressure, and Temperature, except when shown 

as numeric annotations. 

9.6.8 Graph Speed 

When trying to graph large data sets on slower computers it is best to change the “Graph Speed” 

setting to “Fast”. This draws a maximum of 100000 points for every data set in the graph. If any 

important data does not show up on the graph because of the filtering, change this graph 

setting to “Show All Points”. 

9.6.9 Show Grid 

The legend and data table at the bottom of the graph screen can be hidden by unchecking the 

Show Grid checkbox. 

9.6.10 Show Annotations 

All the annotations and gradient point markers on the graph can be hidden by unchecking the 

Show Annotations checkbox. 

9.6.11 Remove Left/Right Graph Padding 

If the Remove Left/Right Graph Padding box is unchecked, the left and right padding will be 

added to the graph to center the graph. If checked, the padding will be removed. 
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Graph with left/right padding. 
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Graph without left/right padding. 
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9.7 The legend 

When you open multiple data sets, the legend on the bottom left is updated to show all of the 

data files and their corresponding data columns. In the example shown, we have two data sets, 

each with two data columns of pressure and temperature.  

 

 

You can click and unclick the boxes next to each legend title. As you do so, the data curve and 

data column is either shown or not shown on the graph. If you click on the main tool title in the 

legend, the data table on the bottom right switches to that corresponding tool. In the example 

above, the data table corresponds to gauge P1220. 
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9.8 The data cursor and data table 

A single left click anywhere on the graph will produce a vertical line or cursor where you clicked. 

At the same time, the data table on the bottom right highlights the row of data corresponding to 

point you clicked on. 

 

Another way to select a data point is to click the corresponding row on the table located at the 

left of the screen. The point on the graph will be highlighted by the broken vertical line. 

 

 

You can use your right and left arrow keys to move the cursor to the left and right on the graph. 

This action will also scroll up and down the data table.  
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If you have multiple data sets displayed. The data table shown will correspond to either the last 

data set that was opened, or the last data set that was clicked on in the legend. 

 

9.9 Zoom and Pan 

When you hold the SHIFT key, the mouse pointer turns into a hand that when clicked will grab 

the graph, dragging the mouse will pan the image on the screen. 

 

Use your scroll wheel to zoom in and out of the screen.  

 

To zoom in on a section of the graph left click and drag the pointer over the area you want to 

zoom in on. 

 

The graph will now only display the area selected 
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To return the graph to its original scale right click and select Set Scale to Default.  
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9.9.1 Burst Event Auto Zoom 

When logging a burst event, the data happens so quickly that can appear as a vertical line on the 

main graph. The software automatically denotes a “Start of Burst” and an “End of Burst” for easy 

reference. 

 

By clicking on either the “Start of Burst” or “End of Burst” the software automatically zooms in on 

that specific burst event so that it better fills the graph window. 

 

Figure 1 Burst data before automatic zoom. 
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Figure 2 Zoomed data after clicking "Start of Burst" on the second burst event. 

 

9.10 Deleting Data Points 

There are a number of ways to delete data using DataCan Download Software. You can select 

data using the left  and right  boundary buttons and then hit the delete button . You 

can delete or modify individual data points in the data table. You can highlight rows of data in 

the data table and delete them.  

 

Left and right boundary lines can be used to delete multiple data points. To delete the start of a 

job, add a left boundary line and press the delete button. Click on the left arrow action button 
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(highlighted) then click on the graph where you want to delete the data. The cursor line is drawn 

where you clicked and the area you chose to delete is highlighted.  

 

You can then press the Delete  button on the action menu. A warning will appear.  

 

The selected points will be deleted and the graph scale will be resized to fit the screen. 
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You can delete the data at the end of the job using the right boundary line button. It is also 

possible to use the boundary lines to delete data in the middle of the job. This is more useful for 

filtering data sets.  

 

To delete a single data point, you must select an entire row of data from the data table. A row of 

data can be selected by clicking on the row number in the data table. 

 

When you have selected the row, the row is highlighted, press the Delete key on your keyboard. 

The point will be deleted. 

 

You will NOT be prompted to confirm the action when using this method, the points will be 

immediately deleted.. 

 

This method can also be used to delete multiple data points by holding either Ctrl or Shift , and 

selecting multiple data points and pressing the Delete key. Alternatively, you can click and hold 

down on the row number and drag your mouse up and down highlighting multiple rows of data 

at once, then pressing the Delete key. 

 

9.11 Filtering Data Points 

If you would like to filter the entire data set, simply press the Filter action button  on top. 
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The filter menu appears and gives you two options:  

Keep 1 out of every _____ points 

Filter Delta Pressure:_____psia.  

 

The first filter option will keep one out of every x points where x is a number entered in the blank 

field provided. This feature is used to simplify the graph and decrease the size of the files used. 

Enter the desired value of x and click OK. In this example a value of 20 will be entered to 

demonstrate the feature. 

 

 

One out of every twenty data points to the left of the filter line will be kept. The rest will be 

removed from the graph. 

 

The second filter option will delete data until the difference between the consecutive points in 

the data is equal to or greater than the value entered in the blank field provided. For example if 

your data set consisted of 1, 2, 3, 4, 5, 6, 7, 8, 9 10 and a value of 5 was entered the sequence 

would be filtered to 1,6. Enter the desired delta pressure filter and press OK. In this example a 

value of 200kPa will be entered to demonstrate the feature. 
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The difference between consecutive points in the selected data will now be at least 200kPa. 

 

To further illustrate here’s what the graph will look like when a value of 1000kPa is used 
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9.11.1 Atmospheric Correction 

In Supervisor Mode, Atmospheric Correction can be applied in the “Filter” menu. This will force 

all pressure values below a certain threshold (this depends upon the sensor type and the 

maximum rating of the sensor) to read an atmospheric value. 

 

Check the “Atmospheric Correction” check box and then click the bottom “OK” button. 
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9.11.2 Pressure Data Smoothing 

In Supervisor Mode, Data smoothing can be applied to the pressure data. When turned “On”, 

data will be smoothed if the pressure change between “Sample Length” number of points is less 

than “Threshold” pressure. In this example, if 5 samples in a row have a pressure change of less 

than 3 psia, then the 5 samples will be smoothed. Data spikes and data large data movements 

will not be smoothed. 
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Select Pressure Data Smoothing “On”, set the “Threshold” pressure and the “Sample Length”. 

Then click the “OK” button. 

 

9.11.3 Temperature Data Smoothing 

Temperature Data Smoothing is similar to Pressure Data Smoothing, except there is no 

threshold. All temperature data points will have a running average smoothing applied. 
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Select Temperature Data Smoothing “On”. Then click the “OK” button. 

 

9.12 Adding, Deleting and Editting Annotations 

DataCan Download Software allows you attach annotations to data points on the graph. Double 

click the data point where you want to add the annotation. The point options window will 

appear. Make sure that the “Annotation” radio button is active. 
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Add the annotation or comments under the events heading. Click OK. 
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The annotation will appear as a note with an arrow pointing to the selected data point. 

 

To move the annotation, point the cursor over the annotation. Press Ctrl + Left Click then drag 

the annotation to where you would like to see it. 

 

To edit or delete an annotation place the cursor over top of it until it turns green. Right click and 

select Edit Point Information from the menu. 
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The point options window will appear. The annotation can be edited and saved by pressing the 

OK button as outlined above. Press the Delete button in the point options window to remove the 

annotation. 
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Another way to delete an annotation is to right click on top of it and select Delete Point 

Information from the menu. 
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9.13 Events Tab 

The Events tab lists all annotations and gradients shown on the graph. 

 

 

9.14 Show Numeric Annotations 

Annotation settings are now changed in the graph settings dialog, which can be accessed by 

pressing the Units / Settings button  on the top side of the graph screen.  See Annotation 

Settings earlier in this manual for more information. 
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9.15 Create a Gradient Plot and Edit Gradient Points 

DataCan Download Software allows you to create a gradient plot. Double click the data point 

where you want to add the gradient point. The point options window will appear. Make sure that 

the “Gradient Point” radio button is active. 

 

 

Select the type of gradient point that is required from the drop down list. 

Single Gradient Point – This is a single point created and stands alone from one gradient stop 

to another. 
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Start Gradient Point – This creates a start gradient point that will be paired with an end 

gradient point representing a range on a gradient stop. Both the start and the end gradient 

points must have the same Gradient Point Index number to be considered a pair. This range can 

be created on each gradient stop. 

End Gradient Point – This creates an end gradient point that will be paired with a start gradient 

point representing a range on a gradient stop. Both the start and the end gradient points must 

have the same Gradient Point Index number to be considered a pair. This range can be created 

on each gradient stop. 

 

Select the Stop Type from the drop down list. The options are “Static” or “Flowing”. 

 

Add the Depth and Total Vertical Depth (TVD) into the Point Options box. Click OK. Start and 

End Gradient Points will have the same TVD and Depth values. The units for depth are set in the 

“Units” dialog. 

 

Each gradient point is added the to “Gradient” and “Events” tables which are stored in the 

“Gradient” and “Events” tabs. 

 

Repeat this step as you move from one gradient stop to another. The following diagram displays 

how Single Gradient Points would be used. 
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The following diagram displays how Start and End Gradient Points would be used. 

 

The gradient point will appear as a note with an arrow pointing to the selected data point. 

 

To move the gradient point, point the cursor over the annotation. Press Ctrl + Left Click then drag 

the gradient point to where you would like to see it. 
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To edit or delete a gradient point step, place the cursor over top of it until it turns orange. Right 

click and select Edit Point Information from the menu.  

 

 

The point options window will appear. The annotation can be edited and saved by pressing the 

OK button as outlined above. Press the Delete button in the point options window to remove the 

gradient point. 

 

Once you have entered your gradient points, click on the Gradient View tab at the top left of the 

graph screen. 
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The gradient tab takes you to a table displaying the Stop number, Depth, TVD, Time (Elapsed 

Time or Real Time), Pressure, Pressure Gradient, Temperature, Temperature Gradient, Events, and 

Pressure Gradient (Log). 

 

You can click on the cells in the table and edit them manually. 

You can toggle from the Single Gradients Table to the Start and End Gradients Table by clicking 

the buttons on the left. 
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The “Table Settings” button can be clicked to change the type of values to be displayed when the 

Start and End Gradients Table is displayed. 

 

 

You can toggle from the Table tab to the Graph tab to see the gradient graph. The graph 

displayed is based on the table view selected under the Table tab. 
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9.15.1 Adding Liquid Level to a Graident Graph 

To add or remove a liquid level indicator from the gradient graph, press the Liquid Level Button 
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This will bring up the Liquid Level Dialog 
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There are two ways to add the liquid level to the graph.  If you know the liquid level and wish to 

enter it manually, check the “Manually Set the Liquid Level” checkbox and enter the level.   

 

If you want to calculate the liquid level using gradient values, select the gas and liquid gradients 

out of the gradient lists, and hit the “Calculate” button.  The calculated level will appear in the 

“Liquid Level” textbox. 

 

Pressing ‘Add’ will add the liquid level indicator to the gradient graph and close the dialog.   

 

If you ever wish to remove the liquid level indicator from the graph, press the “Liquid Level” 

button to bring up this dialog, and then press the ‘Remove’ button in the dialog.  The remove 

button will only appear if there is a liquid level indicator on the graph. 

You can also auto-detect the gas and liquid gradients by pressing the Auto Detect button. 
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Using known normal ranges for gas and fluid gradients, the software will try to determine the 

gradients lines and interface point, and will calculate the liquid level using these chosen points. 

 

NOTE: Due to various well characteristics, it is not always possible to accurately determine the 

liquid level using the Auto Detect method. 
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When you add the liquid level indicator to the graph, a line will be drawn along the depth axis to 

indicate the liquid level.  The space below that line will be shaded.  The liquid level depth will also 

appear in the graph’s legend. 

 

If the liquid level was calculated using a set of gradients (rather than manually entered), an 

additional gradient graph becomes available, showing the gas and liquid gradient lines along 

alongside the plotted pressure points.  This graph can be viewed by selecting the “Gradient 

Analysis” graph from the dropdown list (this graph is shown by default after the liquid level has 

been plotted). 
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To edit the shading color used to indicate the liquid level, right click anywhere on the gradient 

graph, and select “Change Fill Color”.  A color dialog will appear, allowing you to change the 

liquid level fill color. 

  

The Liquid Level line and shaded area will appear in the new color scheme: 
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9.15.2 Estimating Depth Curve using Gradient Points  

A new features starting in Version 3.8.0 is the ability to generate a depth curve using the depths 

of the gradient points. 

For example, here is a graph which has been annotated with start/stop gradients. The first stop is 

at 0 feet, and the 12th stop is at 5,500 feet. 

 

To plot a depth curve using these known depths, right-click on the gauge in the tree on the 

lower left, then select “Calculate Depth” 
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This will bring up a warning, indicating that this operation cannot be undone with the undo/redo 

buttons. Click ‘Yes’ to continue. 

 

 

A depth curve will be generated, connecting the known depth points and extrapolating the 

points in between. The resulting graph will look something like this: 

 

After the depth curve has been generated, you can save this data by hitting the save icon. 
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9.16 Adjusting the start time 

When you have multiple jobs open, it is often valuable to adjust the start times of each file to 

match. 

 Before you can adjust the start times, you need to make sure that the graph time format 

is set to “Real Time”. You can adjust the graph time format by following the steps in 

section 9.4 “Graph Set-Up”. 

To adjust the start time, right click on the tool title in the legend. A drop down menu will appear. 

You can select the “Update Start Date/Time”. 

 

The following operations box will appear. You can toggle the start date/time by a few minutes or 

seconds to move one graphs start time to match the other graphs. 

 

Here is a graph of two tools before the adjustment. 
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Here is the data after I moved P1210 from a start time of 3:51:35PM to a start time of 3:48:35PM. 

 

9.16.1 Setting Start Time to 0 Seconds 

This is a useful function if you have deleted unimportant data at the beginning of the graph, and 

wish for your remaining data to start at time zero.  For instance, if you have the following graph, 

and you delete the front portion: 
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Now you are left with a graph with the same start time as before, but with the first data point not 

occurring until an elapsed time of over 12 hours. 

 

To have the first data point start at 0, right click on the gauge serial number in the legend in the 

bottom left corner, and select “Set Start Time to 0 Seconds”: 
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The graph will now look like this: 

 

Elapsed time now starts at hour 0, and the gauge’s Start Time has been updated. 
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9.17 Adjusting the Line Shift/Scale Properties 

Each of the curves for a particular data set (job) can be adjusted by a shift and/or scale. This 

functionality can be used to adjust slightly skewed curves in a graph and can is available only in 

the Supervisor Mode. (Please refer to the “Supervisor Mode” section of this manual). 

 

Shift refers to a vertical addition or subtraction of the selected curve. 

Scale refers to a vertical multiplication of the selected curve. 

 

To adjust the shift/scale properties, expand the title for a particular job in the legend and right 

click on the curve that requires updating. A drop down menu will appear. Select the “Shift/Scale 

Data” option. 

 

 

The following properties box will appear. The default value for shift is zero and the default value 

for the scale is one. The text boxes accept whole or decimal numbers only and cannot remain 

blank. When desired settings are entered, click the “Update” button. To avoid making any 

shift/scale changes to the selected line, click the “Cancel” button. 
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For example, the following image displays the graph before a line shift/scale is applied: 

 

 

Notice the table below the graph says the Temperature at the point selected is 126.690 degF. 

 

 

Now when a shift of 30 is applied to the Temperature curve (i.e. red curve) for this graph the 

graph appears as follows: 
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Notice the table below the graph now says the Temperature curve when the same point is 

selected is 156.690 degF. 

 

  

To scale the selected curve, follow the same procedure as performing a shift except the scale text 

box needs to be updated. 

If both the shift and scale text boxes are changed in the properties box, the scale will be 

performed to the curve FIRST, and then the shift will be applied to the scaled data. 

Another useful feature is to be able to apply the shift/scale properties between two points on the 

graph by using the left and right boundary buttons located in the action buttons area of the 

screen. 

 

For example, the following graph shows the left and right boundaries (area within boundaries is 

highlighted in blue) on the graph before a scale change: 
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After a scale change of 3 is applied to the red temperature curve, the graph changes in the 

boundary region and appears as follows: 

 

9.18 Adjusting the Line Color and Line Width 

Each of the curves for a particular data set (job) can be adjusted to have a certain color and line 

width. 
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To adjust the line color, expand the title for a particular job in the legend and right click on the 

curve that requires updating. A drop down menu will appear. Select the “Change Line Color” 

option. 

 

The following color box appears where the desired color can be selected: 

 

 

To adjust the line width, expand the title for a particular job in the legend and right click on the 

curve that requires updating. A drop down menu will appear. Select the “Change Line Width” 

option. 
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The following line width property box appears where the desired line width can be set: 

 

9.19 Adjusting the Default Line Width of Curves 

By default the line widths of the curves in the graph is set to 2. To change this option, simply 

click the Units / Settings action button  to the top of the graph. Then change the default line 

width to desired number. The minimum value for the line width is 1 and the maximum is 20.  
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9.20 Adding or Changing a Gauge Label 

Each gauge in the graph can have a label added. This can be done to show where the gauge was 

located in the well, like “tubing” or “annulus”. There is one label stored per serial number, so the 

Pressure, Temperature, Vibration, etc. will each have the same label for one gauge. 

 

To do this, expand the legend to show each reading from the gauge. Right click on one of the 

readings, such as “Pressure”, and click “Edit Label”. 

 

 

The user can now type the new label that they want and press ENTER. 

 

This will change the label in the legend and in the data grid to the right of the legend. 

 

In order for this label to be stored in your data file, make sure to save your file before exiting the 

program. 
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9.21 View the Difference Curve 

When two gauges are plotted at the same time, it is often valuable to see how well each gauge 

tracks the other. After you have adjusted the gauges start time to match, navigate to the 

Difference tab. 
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9.22 Save Graphs 

DataCan Download Software allows you to save your graph using a number of file formats 

including: MS Excel ® (97-2003 or 2007), CSV (Comma Separated Value), Space-Delimited, or 

any number of image files. 

 

There are different methods of saving or capturing your graph image. You can right click 

anywhere in the graph screen and a pop up menu will appear. Then you can choose to “Copy” 

the image, “Print” the image, or “Save Image As…” You can also choose to save from the menu 

bar File -> Save As… 

 

If the “Text or Excel” option is selected, a pop up window will appear asking you to enter the 

output format and whether or not you want an events column in the output file. Enter this 

information and click OK. 

Only line curves that have the checkbox checked in the legend will have data exported to 

the text or excel file. 
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Another option to quickly save or print a graph is to click the Quick Print button  located to 

the top of the graph. 
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When this button is clicked, a PDF of the graph will be generated and displayed. The PDF file can 

be saved to a location on the computer or can be printed. 
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You can also save a graph from the legend on the bottom left. Right click each legend title and 

select Save As… from the menu. 
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9.23 Undo Actions 

You can undo and redo any actions you make to the data files in DataCan Download Software   

 

9.23.1 Undo the last actions that you made 

When you make any actions to the data files such as deleting data points, filtering data points, 

changing the graph units, etc., the Undo action button  on the top side of the graph screen is 

enabled immediately after the action is done. For example, the following image displays the 

graph after data points deletion is applied at the beginning. Notice the Undo action button  

is now enabled, and the legend title is marked with ** at the end indicating the data has been 

changed. 
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To undo the last action, click the Undo action  button. Now the graph is back to the state 

before data points deletion was applied. Another way to undo the last action is by holding down 

the Control and the Z key. 
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9.23.2 Redo actions that you undid 

When you undo the last action that you made, the Redo action button  on the top side of the 

graph screen is enabled. To redo an action that you undid by clicking the Redo action button 

. You can also redo an action by holding down the Control and the Y key. 
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The following image displays the graph after the redo action is done with data points deletion 

applied. 
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10 Reporting  

Enter the Reporting section by clicking on the following icon. Here you can create reports of the 

data recorded by the gauges.  
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10.1 Creating A Report 

To create a report fill out the appropriate fields in the blank spaces provided. 

 

Each tab contains different fields of information. 
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When all of the necessary information has been added to the report press the Generate Report 

button. 

 

A pop up window will appear. Select what you want to be included in the report and press the 

Save As PDF button. 
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Select a location to save the report and press the Save button. 
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Another pop up window will ask you if you want to view the report. If you click yes the PDF 

report will appear. 

10.2 Changing Units 

The “Units” tab has been removed. To change units, either use the “Units” dialog in the graph, or 

if you are connected to a gauge, use the “Change Units” option in the “Configuration” menu. 

10.3 Saving and Loading Job Information 

To create a job file which stores the job information entered, fill out the required fields and press 

the Save Job Info button. 

 

A pop up window will appear and tell you the information has been saved successfully. Press OK. 
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The job information can be loaded by pressing the Import button. 

 

Select the location of the job file and press the Open button.  

Enter what job information you want to be included and press the Import button. 
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The fields will now contain the information saved in the job file. 
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You can also save the job information as a CSV file for use in Excel by pressing the Save As Excel 

button. 
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10.4 Exporting Job Information 

To export a job file, fill out the required fields and press the Export button. Unlike saving job 

information, exporting will allow choosing the filename where the job information entered will 

be stored. This feature is useful when you want to create a template for different job information. 

To import the already created job information template, click the Import button. 
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You can also clear the entire job information page by clicking the Clear Job Info button. 
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11 Real Time Logging 

The real time logging feature is used for live data logging in conjunction with the permanent 

surface system or surface logger.  It will create a text file saved to the computer while logging.  

Real time logging is found under the Utilities tab. 
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To begin logging press the Start Sampling button.  A configuration window will pop up. 

 

You have the option to change the units for time, pressure, and temperature and the format of 

time and date. It also allows the user to choose which time format will appear in the file 

generated.  The data file can be saved in one or two locations if preferred. 

The display window size is the max amount of time that will be displayed. When this is reached 

the old data will be eliminated and only the current window size of data is shown.  If the user’s 

computer is too slow to handle that amount of time an error message will show and it will 

automatically scale smaller. 

 If the Append data to existing file box is checked then the data will be added to whatever 

existing text file is chosen. 
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The graph will auto scale as data is recorded but the scale can be changed by checking the 

Change Scale box. When all the information is filled out press OK. 

 

 

The graph will now begin generating and the real time pressure and temperature will be 

displayed on the left. Below the graph is a chart showing all the data that is being saved to file.  

The user can hide this and show just the graph by pressing Hide Data. 
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The sample rate can be adjusted using the arrows in the sample rate box or by typing in a 

number. 

 

Pressing the Pause Graphing button will stop the graphing temporarily while still writing the 

data to file.  To continue press the same button which will now say Continue Graphing.  When 

the graphing is continued it will show all the data that was recorded while it was paused.  

Pausing the graph will also cause the data chart below the graph to stop updating temporarily. 

The real time temperature and pressure values on the left will change to a yellow color and 

continue updating while the graph is paused. 
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While the graph is paused the user can now zoom, pan and use the features available from right 

clicking.  These are done the same way as in Diagnostics. These features are only available when 

the graph is paused. 

 

The axis scale can be changed by pressing the Change Axis Scale button or by right clicking and 

selecting Change Axis Scale. 

 

When the graph is paused the user can also select certain points on the graph and have them 

highlighted in the data chart below the graph.  When a point is selected a dotted line will run 

vertically through it.  As well, if a row of data is selected the line will appear on the graph for that 

point. 



 

 

Copyright 2020 

 

Page 158 

of 193 

 

 

 

 

 

To stop recording data press the Stop Sampling button and click Yes when it asks if you want to 

stop logging.   
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11.1 Surface Box 

11.1.1 Switching Gauges 

When a different down hole gauge is used (a different serial number), the calibration files 

for that gauge must be updated in the surface box.  

Refer to the “Load Calibration Files” section further down for a detailed description on how this is 

accomplished. 

11.1.2 Operating Sequence 

In general, the following sequence of events is required to operate a DataCan memory pressure 

gauge: 

• Wire the Surface Box as outlined in Section 15.4.2. 

• If necessary tune the Surface Box as outlined in Section 15.4.3. 

• Program the surface box using DataCan Download Software as outlined previously in this 

manual 

• Disconnect the surface box from the DataCan Communication Cable. 

• Ensure tool specs meet requirements for the job. Assemble tool as outlined in the tool 

manual. 

• Run the tool down hole. 

• Reconnect the DataCan Communication Cable to the Surface Box and computer to down 

load and process the data. 

11.1.3 Surface Box Tool Assembly 

The following sequence of events is required to assemble a DataCan permanent surface box: 

• Ensure the power is off. The switch shown below will be in the outward (flush) 

position. 
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• Connect 12V power supply and tool inputs to the terminal strip as shown below. 

 

 



 

 

Copyright 2020 

 

Page 161 

of 193 

 

 

• Turn the system on by pressing the power button to the inward position. Wait 10 

seconds for the firmware to activate. If the display is blinking then the system is   

running. If the display is NOT blinking then the system needs to be tuned as outlined 

in the next section. 

 

The following sequence of events is required to assemble a DataCan Rack Mount surface box: 

• Ensure the power is off. The switch on the left of the box will be in the middle position. 

 

• Connect the 12V power supply and tool inputs to the terminal strip OR connect to 120-

240V AC current instead of 12V DC, both of which are shown below. 

       

Turn on the system by either clicking the switch upwards for 120-240V AC, or downwards for 12V 

DC, depending on how the surface box is connected to the power supply. If the display is 

blinking then the system is running. If the display is NOT blinking, then the system needs to be 

tuned as outlined in the next section. 
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11.1.4 Tuning the System 

For the permanent surface box: 

• Open the front panel by rotating the knob shown below counterclockwise. 

 

• Locate the circuit board inside the surface box. 
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• Locate the potentiometer knobs on the circuit board. Turn the knobs 

counterclockwise as far as they will go to set the resistance to zero. 

 

 

• Connect the oscilloscope to the board by connecting the probe to the wire loop 

(shown below) that is located below the potentiometer knobs. Connect the alligator 

clip to any ground wire. 
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• The resistance test points are provided to determine the resistance value of both 

potentiometers for future use. 

For the Rack Mount surface box: 

• Use the two knobs located at the front of the surface box labeled COARSE and FINE 

to tune the system. Turn the knobs counterclockwise as far as they will go to set the 

resistance to zero. 
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• Connect the oscilloscope to the connections labeled TEST POINT+ and the ground to 

TEST POINT- as shown below.

 

 

 

For both Permanent and Rack Mount surface box: 

 

• The first potentiometer knob (on the left for the regular surface box and on the top 

labeled COARSE for the Rack Mount surface box) is the Stage 1 potentiometer. 

Rotate the first potentiometer knob until a square-wave signal is produced (shown 

below). 

• The second potentiometer knob (on the right for the regular surface box and on the 

bottom labeled FINE for the Rack Mount surface box) is the Stage 2 potentiometer. 

As you rotate this potentiometer, the stage two gain will increase. Once the signal is 

large enough, the display will begin to blink. This indicates the system is recording 

samples from the down-hole tool. If the gain is increased too much the signal will 

distort (shown below) and no samples will be received. 
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Correct Signal After Tuning 

      

 

 

Over-Correction Of Signal After Tuning 

      

11.1.5 Using the Software 

Open the DataCan Download Software and connect to the surface box. A pop-up window will 

appear to give you easier access to software features. 
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Continue as Normal closes the window. It has the same effect as clicking the Cancel button. 

Download Data moves to the Download page where data can be downloaded from the 

memory. 

Program Sample Rate switches to the Program page for programming single or multiple rates. 

Real Time Logging lets you perform real time sampling. 

Load Calibration Files loads a new calibration file. (See next section) 

11.1.6 Load Calibration Files 

To load a new calibration file, click the Load Calibration Files option from the DataCan Easy 

Start window after connecting to the surface box. Then the following window will appear to 

navigate files. Click the OK button to load a new calibration file. 

Note:  In order to use a different serial number for the system, you must load a new 

calibration file. 
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11.1.7 Finding the Modbus Address 

The Modbus address of the surface box can be found on the “Info” page at the bottom. 
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11.1.8 Find Surface Gauges 

In order for the main unit to recognize that there are surface gauges connected to it, the “Find 

Surface Gauges” routine must be run in the software. 

 

In the menu, click “Configuration -> Find Surface Gauges” 

 

 

The routine will run automatically. If any surface gauges are found, a dialog appears showing the 

serial numbers of each gauge connected. 

 

If no gauges are found, the following dialog will appear. 
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If gauges are found, the user has the option to change the label for each surface gauge. This 

label will appear in the downloaded file and in the graph. The labels are stored in the memory of 

the main surface unit, so you can download the data from a different computer and still have the 

same labels for each surface gauge. 

 

To add or change a label for a surface gauge, click in the correct box under “Label” and type the 

label(s) that you want. Then click the “OK” button. 

 

11.1.9 Change Gauge Labels 

If the user would like to attach a label, such as “tubing” or “annulus”, to either a downhole or 

surface gauge, this can be done in the menu by clicking Configuration -> Gauge Label Setup. 
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A dialog will appear listing the downhole and surface gauges. You can change the label by 

clicking in the appropriate box and typing the new label. When complete, click the “OK” button. 

 

 

The “Device Number” column will display “Downhole” for the downhole gauge, and a number (1, 

2, etc.) for the Modbus address of each surface gauge. The “Serial Number” column shows the 

serial number of each attached gauge. 
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11.1.10 Show or Hide Surface Gauge Temperature 

For surface pressure gauges, the temperature reading from these gauges can be shown or 

hidden when downloading. The default is to have this data hidden. 

To change whether is it shown or hidden, in the menu, click Configuration -> Show Surface 

Temperature. When this is enabled, a checkmark will appear beside the selection. 

 

11.1.11 Set up 4 to 20 mA Output 

Absolute Maximum Voltage in the 4 to 20 mA loop: 36V 

Minimum Voltage: 8 V 

Recommended Voltage: 12 to 24 V 

 

The setup page is found in the Configuration menu under 4 to 20mA Output. 
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The 4 to 20 mA Output can be set up to output based upon the temperature or the pressure 

reading. Select the appropriate radio button to use either pressure or temperature. 

 

  

The value representing 4 mA and the value representing 20 mA are set in the appropriate boxes. 

As an example, if 0 psia was set as the low value (4 mA) and 10 000 psia was set as the high value 

(20 mA), when the downhole gauge has a pressure of 5 000 psia, the output would be 12 mA. 

When complete, click the OK button to save this to the surface box. 

 

 

11.2 Wellhead Logger 

11.2.1 Installation 

The DataCan wellhead logger is shipped with an adapter (½” NPT, ¼” NPT or Autoclave) that 

allows it to be mounted almost anywhere.   

• Thread the adapter to the wellhead logger using the appropriate size of wrench 
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Note:  Failure to use a wrench for attaching fittings and mounting the logger can result in     

damage to the logger. 

 

• Using a wrench, attach the wellhead logger assembly to the pressure source 

 

11.2.2 Operating the Wellhead Logger 

• Unscrew the front face of the Kilark case.   
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• Connect the logger to a computer using the DataCan communication cable. Program the 

surface box using DataCan Download Software as outlined previously in this manual 

• Press the on/off switch located above the display.  When the LED light on the button is 

green the logger is turned on. 

• Replace the front of the Kilark case 

• The display will show the real time pressure and temperature data while the logger 

records this data.   

• To obtain data remove the front of the case again and connect the logger to a computer.  

Download the data using the procedure outlined previously in this manual (Section 7.7) 

 

11.3 Bubble Tube Thermocouple Wellhead Logger 

11.3.1 Software Setup 

Connect the gauge to a DataCan Download cable, then connect to the DataCan Download 

software. 

On connect, when prompted, set the time and date to now by clicking “OK”. 

 

11.3.2 Information Page Setup 

To test the real time clock chip, press “Get Time” a few times and make sure the time / date are 

correct and that the time is incrementing properly. 
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Put the DataCan Download software into Supervisor Mode (press “CTRL+SHIFT+D” on your 

keyboard). Program the default values of: G = 0.028762, TVD = 0 m, AWBT = 25 degC, Offset = 0 

degC and “K Type” for the thermocouple type. Press the “Save Notes to Tool” button to store 

this information to the gauge memory. 
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11.4 Multi-Channel Surface Logger 

11.4.1 Installation 

The DataCan multi-channel surface logger is shipped with an adapter (½” NPT, ¼” NPT or HF4) 

that allows it to be mounted almost anywhere.   

• Thread the adapter to the wellhead logger using the appropriate size of wrench 

Note:  Failure to use a wrench for attaching fittings and mounting the logger can result in     

damage to the logger. 
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• Using a wrench, attach the wellhead logger assembly to the pressure source 

11.4.2 Operating the Surface Logger (Without Radio) 

• Connect the surface logger to a computer using the DataCan surface logger 

communication cable.  Program the surface box using DataCan Download Software as 

outlined previously in this manual. 

• Install transmitters to pressure source using appropriate wrench.  Plug the cables into the 

side of the surface logger and into the transmitters. 
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• Press the button labeled On/Off located below the display.  When the LED light on the 

button is green the logger is turned on. 

• The display will show the real time pressure and temperature data for all channels while 

the logger records this data.   

• To obtain data plug the DataCan surface logger communication cable into the port 

located below the display and a USB port on a computer.  Download the data using the 

procedure outlined previously in this manual (Section 7.7) 

11.4.3 Operating the Surface Logger (With Radio) 

• Connect the surface logger to a computer using the DataCan surface logger 

communication cable.  Program the surface box using DataCan Download Software as 

outlined previously in this manual. 

• Install transmitters to pressure source using appropriate wrench.   

• Press the button labeled On/Off located below the display.  When the LED light on the 

button is green the logger is turned on. 

• The display will show the real time pressure and temperature data for all channels while 

the logger records this data.   

• To obtain data plug the DataCan wireless Zigbee receiver into a USB port on a computer.  

Download the data using the procedure outlined previously in this manual (Section 7.7) 

• At times it may be necessary to turn off all wireless transmissions on the well site.  To 

disable radio transmission on the surface logger press the button labeled Transmission 

On/Off, located below the display. 
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11.4.4 Connecting the Radio in the software 

Connect the DataCan Wireless Zigbee Receiver to your computer. 

 

Click the Radio option near the Connect button to find all connected wireless communication 

cables. 

 

The COM port for the wireless receiver is automatically detected by the software. If no COM 

ports are found, please consult installing the drivers in DataCan Download Software Installation 

and try again. 
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11.4.5 Wireless Logging 

If the COM port is successfully detected by the software, simply press the Connect button to 

search all wireless logger(s) nearby. Please make sure that the DataCan Download Cable is 

unplugged before pressing the Connect button since wireless communication is disabled when 

the DataCan Download Cable is plugged to the logger. 

 

After clicking the Connect button, the following dialog will appear. It usually takes less than 30 

seconds to find all wireless logger(s). However, depending on your wireless signal, it may take up 

to one minute. 

 

If no wireless loggers are found, the following dialog will appear. 

 

If wireless logger(s) are found, you have the option to select which logger you like to obtain data 

from. 
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It also allows you to change the sample rate using the arrows in the sample rate box or by typing 

in a number from 2 seconds to 30 seconds. 

 

If the Append data to existing file box is checked, then the data will be added to whatever 

existing text file is chosen. 
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If you are ready to start collecting data from the logger wirelessly, simply click the Start button. 

 

 

After clicking the Start Button with Append data to existing file unchecked, the following 

dialog will appear for you to choose the text file to which data will be added. 
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Finally, choose if you like to show surface temperature by clicking the Yes or No button. If you 

choose not to show surface temperature, only pressure data will appear in the graph and data 

chart. 

 

 

The graph will now begin generating from the wireless logger. Below the graph is a chart 

showing all the data that is being saved to file. The user can hide this and show just the graph by 

pressing Hide Data. 
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Pressing the Pause Graphing button will stop the graphing temporarily while still writing the 

data to file. To continue, press the same button which will now say Continue Graphing. When 

the graphing is continued it will show all the data that was recorded while it was paused. Pausing 

the graph will also cause the data chart below the graph to stop updating temporarily. 

 

While the graph is paused, you can now zoom, pan, and use the features available from right 

clicking. You also have the options to change the Sample Rates, Units, Maximum Window 

Size, and Axis Scale. The Maximum Window Size is the maximum amount of time that will be 

displayed in the graph. When this is reached the old data will be eliminated and only the current 

window size of data is shown. Although the graph shows the maximum amount of time you have 

selected, the data file will contain all data from the beginning of logging to the end. 

  



 

 

Copyright 2020 

 

Page 186 

of 193 

 

 

Furthermore, you can also select certain points on the graph and have them highlighted in the 

data chart below the graph. When a point is selected a dotted line will run vertically through it. 

As well, if a row of data is selected the line will appear on the graph for that point. 

 

To stop recording data press the Stop Sampling button and click Yes when it asks if you want to 

stop logging. 
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11.4.6 Wireless Logger Setup 

To change the logger setup, connect the logger to the software, then enter supervisor mode by 

pressing Ctrl + Shift + D simultaneously on the keyboard. Next, select the Logger Setup option 

from the Configuration menu bar at the top.  
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The following dialog box will appear: 

 

Choose the 8-character long wireless network name that uniquely identifies your wireless 

network. Also, choose the 16-character long password that will be used to encrypt data 

transmission. Next, hit the Save button to save the changes in the tool memory. 

Note:  The setup will take effect after resetting the tool power. Reset the tool power 

by turning it off and turning it back on. 

In order for the wireless logger to function properly, the Wireless Enable option should be on, 

and the Number of Supported Surface Sensors should be set to 4. 

Now, write down your network name and password somewhere because the same network 

name and password should be assigned to the DataCan Wireless ZigBee Receiver for wireless 

communication to function properly. The next section will describe how to setup the DataCan 

Wireless ZigBee Receiver. 
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You can also change the preferred operating channel number(s) used for the wireless network in 

advanced mode. To switch to advanced mode, press Ctrl + Shift + Alt + A simultaneously on 

the keyboard. 

 

The software will use the channel numbers 12, 15, 18, 21, and 24 by default. The “good” 

operating channel will be determined from the list of Scan Channels when forming the wireless 

network. The Scan Duration is the exponent value to calculate the time to spend on determining 

the operating channel for the network to operate from the list of scan channels. Determining the 

operating channel time is measured as: (Number of Scan Channels) * (2 ^ Scan Duration) * 15.36 

milliseconds. By default, the software will use 2 as scan duration. 

With 5 scan channels and 2 scan duration, it will spend about 307.2 milliseconds ( = 5 * (2 ^ 2) * 

15.36 milliseconds) on determining the operating channel. Determining the operating channel 

time longer than 400 milliseconds could cause slow searching time for wireless loggers. Thus, it is 

best to keep the number of scan channels at most 5 and scan duration at most 2 or 3 depending 

on the number of scan channels. 
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Please use the default values if unsure. Also make sure to use the same values for the DataCan 

Wireless ZigBee Receiver if you change these values. 
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11.4.7 DataCan Wireless ZigBee Receiver Setup 

To change the DataCan Wireless ZigBee Receiver Setup, disconnect the logger from the DataCan 

Download Cable and unplug the cable. Next, connect the DataCan Wireless Zigbee Receiver to 

your computer and click the Radio option near the Connect button, then select the Wireless 

USB Adapter Setup option from the Configuration menu bar at the top. 

Note:  There is no need to click the Connect button to change the DataCan Wireless 

ZigBee Receiver Setup. 

 

The following dialog box which is similar to the Logger Setup will appear: 

 

Now, use the same network name and password that were used for the Wireless Logger Setup in 

the previous section, then hit the Save button to save the changes in the DataCan Wireless 

ZigBee Receiver. Please make sure that the wireless logging works after modifying the network 

name and password. 
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If you changed the Scan Channels and Scan Duration for the Wireless Logger Setup in the 

previous section, the same values should be used to setup the DataCan Wireless ZigBee Receiver 

as well. To change the Scan Channels and Scan Duration, enter advanced mode by pressing Ctrl 

+ Shift + Alt + A simultaneously on the keyboard. 
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11.4.8 List of ZigBee Wireless Channels 

The table below shows the list of channels available for ZigBee wireless in the 2.4 GHz band. The 

highlighted rows are the default channels that the software will use. 

 

Channel Number Frequency  Channel Number Frequency 

11 2.405 GHz  18 2.440 GHz 

12 2.410 GHz  19 2.445 GHz 

13 2.415 GHz  20 2.450 GHz 

14 2.420 GHz  21 2.455 GHz 

15 2.425 GHz  22 2.460 GHz 

16 2.430 GHz  23 2.465 GHz 

17 2.435 GHz  24 2.470 GHz 

 


